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This section provides tips and techniques that can help you to set up a
scheduled or instant meeting effectively.

Choosing a scheduler
To schedule a meeting, you can choose either of the following
schedulers:
■ Advanced Scheduler: Lets you set all options for your meeting. These

About this guide
Successful WebEx Meetings provides tips and techniques that you can
use to conduct more effective meetings on the Web. This guide assumes
that you are already familiar with the basics of Meeting Center, and
thus it does not provide detailed instructions for using Meeting Center.

options including basic meeting information, recurrence,
teleconferencing, the attendee list, registration, agenda, attendee
privileges, security options, and other meeting details.
■ Quick Scheduler: Lets you set a smaller number of options for your

meeting. These options include basic meeting information,
teleconferencing, and the attendee list.

Securing your meeting
Note

To obtain detailed instructions for using the options and
features that this guide describes, refer to the online Help on your
Meeting Center Web site.

You can provide security for your meeting by doing any of the
following in the Advanced Scheduler:
■ Require a password: If you specify a password for the meeting, attendees

must provide this password to join the meeting.
Many of the tips and techniques in this guide were provided by meeting
service users like yourself. If you have a tip that you want to share with
other users, please send a detailed description of your tip to
docs@webex.com.

■ Schedule an unlisted meeting: An unlisted meeting does not appear on the

meeting calendar on your Meeting Center Web site. To join an unlisted
meeting, attendees must click the Unlisted link under Attend a Meeting on
the navigation bar, then provide a unique meeting number.

Meeting Center 8
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■ Exclude the meeting password from email invitations: If you have

specified a meeting password, you can prevent the password from
appearing in the email invitations that your Meeting Center Web site
automatically sends to attendees.
■ Require attendees to log in: You can require that attendees have a user

account on your Meeting Center Web site. Thus, attendees must log in to
your site before they can attend a meeting.
■ Require attendees to register for the meeting: You can require each

attendee to fill out a registration request that includes his or her name,
email address, and other information that you require, and then send the
request to you. You can then accept or reject each registration request.
The level of security that you choose depends on the meeting's
purpose. For example, if you schedule a meeting to discuss your
company picnic, you might specify only a simple password for the
meeting. On the other hand, if you schedule a meeting in which you
will discuss sensitive financial information, you may want to specify
that the meeting is unlisted and require attendees to log in to your site
to attend.
Note

Once you start a meeting, you can provide additional
security by “locking” the meeting. For details, see Preventing
unauthorized access to a meeting in progress on page 6.

To set up a recurring meeting, specify recurrence options on the Date
& Time page in the Advanced Scheduler.

Including a teleconference
When scheduling a meeting, you can select one of the following
teleconferencing options in either the Quick Scheduler or Advanced
Scheduler. To access these options in the Advanced Scheduler, click
Teleconference on the right; in the Quick Scheduler, click Change
audio option.
■ None: Select this option if you do not need to set up a formal

teleconference or use a teleconferencing service—for example, if you want
to meet with only one other attendee.
Important

If you schedule a meeting without using a
teleconferencing service, it is recommended that you clearly specify
in your email invitation how you plan to provide audio for the
meeting; otherwise, attendees may not realize that your meeting
includes audio. For example, you can inform attendees that you will call them
once the meeting starts. To specify this information, you can create a custom
email invitation. For details, see Creating a custom email invitation for
attendees on page 4.

■ WebEx teleconferencing service: The meeting includes an integrated

teleconference. If you select this option, select one of the following types
of teleconferences:

Scheduling a recurring meeting
If you want to host a meeting on a regular basis, you can specify one of
the following recurrence patterns when scheduling a meeting using the
Advanced Scheduler:
■ Daily recurrence
■ Weekly recurrence
■ Monthly recurrence
■ Yearly recurrence



Attendees call in: Select this option to have attendees call a phone
number to join a teleconference.



Attendees receive a call back: Select this option to have the
teleconferencing service call attendees to connect them to the
teleconference.
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Important

In a call-back teleconference, only meeting
attendees who have direct phone lines can receive a call back from the
teleconferencing service. If a receptionist answers the call from the
service, or the attendee's phone system uses a recorded greeting for incoming
calls, the attendee cannot receive a call back. However, an optional call-in
phone number for the teleconferene is always available in the Meeting
window.
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Note

An Integrated VoIP conference does not start automatically
once you start a meeting. You must start the Integrated VoIP
conference as follows: On the Tools menu, point to Integrated VoIP,
and then choose Start Conference.

Note
■ Personal Conference Number: Available only if your user account

includes the Personal Conference Number option. Select this option to use
your Personal Conference Number account for the teleconference. With a
PCN account, you can use the same conferencing numbers for all your
meetings and set the access codes that you want to use to start the
teleconference, and the access codes that you want attendees to use to join
the teleconference.
■ Other teleconferencing service: Select this option if you want to use

another teleconferencing service provider or an internal teleconferencing
service. If you type instructions for joining the teleconference in the box
that appears, the instructions automatically appear in a message box once
an attendee joins the meeting.

Including an Integrated VoIP conference
When scheduling a meeting, you can choose to use Integrated VoIP in
addition to or instead of a teleconference. This option allows attendees
to speak to each other using voice over IP (V0IP)—an Internet-based
telephony service—rather than the traditional telephone system.
Integrated VoIP can be useful in the following cases:
■ Your meeting includes remote attendees who do not want to be charged

for long-distance phone calls.
■ Your meeting will not involve much interaction—for example, attendees

will listen to a presentation instead of engage in a discussion.

For more information about using Integrated VoIP,
including system requirements, refer to the online Help on your
Meeting Center Web site.

Granting privileges to attendees
When scheduling a meeting using the Advanced Scheduler, you can
grant privileges to or remove them from attendees, using the options
on the Attendee Privileges page. The privileges that you select
determine whether all attendees can share documents, view shared
documents independently, annotate shared documents, and so on.
For most meetings, it is recommended that you accept the default
privileges, and then grant additional privileges as needed to all
attendees or individual attendees during the meeting. That way, you
can maintain more control over the meeting. For example, if you are
giving a presentation and want to ensure that attendees follow along
with your slides, you probably do not want to grant them the View any
page privilege, which lets them navigate your presentation
independently.

Letting attendees join a meeting before its scheduled
starting time
If you use the Advanced Scheduler, you can let attendees join a meeting
before you actually start it. For example, you can specify that attendees
can join a meeting up to 10 minutes before its scheduled starting time.
This option, which is available on the Date & Time page in the
Advanced Scheduler, helps to prevent attendees from having to wait for
you to start the meeting before they can join it.

4 of 15

If you do let attendees join a meeting early, you can automatically share
a presentation or document once an attendee joins the meeting. For
details, see Sharing a presentation automatically on page 4.

Sharing a presentation automatically
If you let attendees join a meeting before its scheduled starting time
using the Advanced Scheduler, you can share a presentation or
document automatically. The presentation or document can inform or
entertain attendees while they are waiting for you to start the meeting.
To share a presentation or document automatically, you must select it
when scheduling a meeting. The presentation or document must be in
the WebEx Universal Communications Format (UCF). To save any
document or presentation as UCF, use the WebEx Universal
Communications Toolkit or the WebEx Document Manager, which are
available on the Support page on your Meeting Center Web site.
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Creating a custom email invitation for attendees
If you invite attendees to a meeting when scheduling it, Meeting Center
automatically sends invitation email messages to the attendees.
However, you can modify the automatic email message, as follows:
Initially invite only yourself to the meeting. Once you receive the
invitation email message, you can modify it as needed, and then
forward it to attendees. In your custom invitation email message,
ensure that you include all necessary meeting information that the
original message contained, such as the date and time for the meeting,
the meeting agenda, the URL for joining the meeting, and voice
conferencing information.
Note

Do not modify the meeting confirmation email message
that you receive. This message contains information and URLs that
you need to host the meeting.

Using meeting templates
To save time when scheduling a meeting, you can set up a meeting
template. A meeting template automatically sets all the options your
meeting, except the password and date and time options.
To set up a meeting template, use the Advanced Scheduler or Quick
Scheduler top set the options you want to use for your meetings, and
then click Save As Template at the bottom of the scheduling page. The
next time you want to schedule a meeting, simply choose the template
from the Set options using template drop-down list at the top of the
Advanced Scheduler or Quick Scheduler page. Before you schedule the
meeting, you can change any of the options that the template applied
to your meeting.

Updating information about a scheduled meeting
You can update any information about a meeting, including its starting
time, recurrence pattern, or list of invited attendees. Once you modify
a meeting, you can choose to send attendees a new invitation email
message that informs them that you have modified information about
the meeting. Attendees whom you removed from the attendee list
receive an email message informing them that you have retracted their
invitations.

Letting another user schedule a meeting on your
behalf
You can grant permission to one or more meeting service users to
schedule meetings on your behalf. Once another user schedules a
meeting for you, the meeting appears in your list of meetings on the
My WebEx Meetings page. You can then start the meeting and host it
as you normally can when you schedule meetings yourself.
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To let another user schedule a meeting for you, specify that user in your
user profile on your Meeting Center Web site. You can select only a user
who has an account on your Meeting Center Web site.

Using Microsoft Outlook to schedule a meeting
If you use Microsoft Outlook 2000 or later, and your Meeting Center
configuration includes the WebEx Integration to Outlook option, you
can schedule, start, and join online meetings using Microsoft Outlook.
For instructions on using Integration to Outlook, refer to the guide
WebEx Integration to Outlook User's Guide. This guide is available on
the Support page on your Meeting Center Web site.

Using One-Click Meetings
If you often meet with others to spontaneously collaborate on
documents, spreadsheets, and so on, you can set up One-Click Meeting
shortcuts for your Microsoft Office applications. Then, while working
in a Microsoft Office application, you can instantly start a meeting and
share the document that is open in that application.
Similarly, you can set up a One-Click Meeting shortcut for your
Windows shortcut menu. This shortcut lets you right-click any
document or application on your computer to instantly start a meeting
and share that application or document in the meeting.
To set up One-Click Meeting shortcuts, do either of the following on
your Meeting Center Web site
■ Click My WebEx > My Meetings > One-Click Setup
■ On the navigation bar, click Host a Meeting > One-Click Meeting.
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Starting a scheduled meeting
Meetings do not start automatically at their scheduled times. As the
meeting host, you must first start a meeting before attendees can join
it. Thus, it is recommended that you start a meeting about 10 minutes
before its scheduled starting time, to accommodate any attendees who
want to join a few minutes early.
Alternatively, you can let attendees join a meeting before you actually
start it. In this case, the meeting automatically becomes “open” at a
time that you specify when scheduling it. For more information, see
Letting attendees join a meeting before its scheduled starting time on
page 3.

Helping attendees to find your Meeting Center Web
site
If attendees have trouble finding your Meeting Center Web site to join
a meeting, verify that they are using the correct URL. Some common
mistakes that users make:
■ Typing www in the URL. Meeting Center Web sites do not include the

www server name. Instead, these sites include your organization's name,
in the following format:
http://<your_organization_name>.webex.com
■ Typing webx instead of webex in the URL.
■ Typing http instead of https, if your site is secured with SSL (Secure

Sockets Layer). A secure site's URL uses this format:
https://<your_organization_name>.webex.com

Helping attendees to join a meeting

Starting and conducting a meeting
For meeting hosts
This section provides tips and techniques for starting and conducting
a meeting.

If attendees have trouble joining a meeting, they may be attempting to
join a meeting that you have not yet started. On the meeting calendar
on your Meeting Center Web site, under Status, the text Join Now and
a green indicator appear only after you start the meeting. Otherwise,
the text Not started appears
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.Because a meeting’s status can change at any time, an attendee can
periodically click the Refresh button on the page to determine whether
you have started the meeting.

You can help to avoid the need for attendees to refresh the meeting
calendar by letting them join the meeting before you actually start it.
For details, see Letting attendees join a meeting before its scheduled
starting time on page 3.
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On the Communicate menu, point to Integrated VoIP, then choose
Start Conference.
Before starting or joining an Integrated VoIP conference, you can use
the Audio Setup Wizard—which is available on the Communicate
menu—to ensure that your microphone and speakers are set to their
optimal levels.
Note

For more information about using Integrated VoIP and the
Audio Setup Wizard, refer to the online Help on your Meeting Center
Web site.

Preventing unauthorized access to a meeting in
progress
Once all required or invited attendees have joined a meeting, you can
“lock” the meeting by restricting access to it. Restricting access to a
meeting prevents anyone else from joining it. To lock a meeting, choose
Restrict Access on the Meeting menu.

Presenting information
For presenters
This section provides tips and techniques for sharing presentations
and applications, polling attendees, and recording meetings.

Helping attendees to join a teleconference
If your meeting includes an integrated call-in or call-back
teleconference, or a third-party teleconferencing service, instructions
for joining the teleconference automatically appear in a message box
on an attendee’s screen once that attendee joins the meeting. Attendees
can also obtain instructions for joining a teleconference at any time
during the meeting, by choosing Join Teleconference on the
Participant menu. If your meeting includes an integrated call-in
teleconference, the call-in number also appears on the Info tab in the
content viewer.

Preparing for your meeting
These tips can help you to avoid problems and ensure that your
meeting runs smoothly:
■ Before you start a meeting, ensure that your computer and network are

working properly to avoid any unexpected problems during the meeting.
■ Place all the files that you intend to share in a single folder, so you can

quickly locate them during the meeting
■ Start your meeting early, and practice sharing the documents and

Using Integrated VoIP
If, when scheduling or starting an instant meeting, you included an
Integrated VoIP conference, you must start the conference after you
start the meeting:

applications that you intend to share with attendees. That way, you can
troubleshoot any problems before attendees join the meeting.
■ Ensure that you have the URL for your backup meeting site handy, in case

your primary site is unavailable. If you do not know the URL for your
backup site, ask your Meeting Center site administrator.
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■ Once you start a meeting, write down the meeting number, host key, and,
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Then click the Take Snapshot button:

if you are using the integrated teleconferencing service, the teleconference
number. These numbers appear on the Info tab in the content viewer

Using an assistant presenter
If you want to focus on speaking during a meeting, or want to view
your presentation from an attendee's perspective, you can assign the
presenter role to another attendee. This attendee can “drive” the
presentation, by advancing slides and sharing applications as you need
them.

Personalizing your meeting with video
If you attach a video camera to your computer, you can use video to
introduce yourself at the beginning of a meeting. To send live video to
participants, simply open the Video panel in the Meeting window.

Taking a snapshot of video
If you want participants to see your image during a meeting, you can
take a snapshot of your video image, and then paste it on a whiteboard
in the content viewer. That way, you can close the Video panel, thereby
saving bandwidth and improving the performance of Meeting
Manager. To take a snapshot of video, on the Video panel, click the
View Floating Video Window button:

Take Snapshot button

Using annotation tools
When sharing a presentation or application, use the annotation tools
to highlight text or graphics, emphasize points, and draw and write
notes. If you are conducting a meeting with few attendees, you might
want to allow attendees to annotate your shared presentation or
application. Attendees can use annotation tools, for example, to point
to areas on a slide about which they want to comment or ask a
question.
When you share a presentation, annotation tools appear above the
content viewer:
Annotation tools

View Floating Video Panel
button

To access annotation tools while sharing an application, in the title bar
of the shared application, click the Sharing button, and then choose
Start Annotation.
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The Tools panel appears:

Choosing an option for sharing Web pages
During a meeting, you can display Web pages to attendees in one of
three ways:
■ Web browser sharing: Web browser sharing allows you to take attendees

Choosing an option for sharing presentations or
documents
Meeting Center provides the following options for sharing a
presentation or document:
■ Sharing a presentation or document in the content viewer: The

Presentation or Document command on the Share menu displays a
presentation or document in the content viewer. If you used Microsoft
PowerPoint to create your slides, the content viewer also displays any
animations and transitions on the slides. This sharing option provides a set
of annotation tools that both you and attendees with annotation privileges
can use; viewing options, such as thumbnails and full-screen view; and
simultaneous use of the entire Meeting window, including the participant
list and chat.
■ Sharing a presentation as an application: Instead of displaying a

presentation or document in the content viewer, you can open the
presentation or document in the application with which it was created,
and then share the application. Sharing a presentation or document as an
“application” lets you or an attendee edit the slides or pages during the
meeting.
■ Sharing a presentation or document by sharing your desktop: Sharing

your desktop provides the same benefits as sharing your presentation as an
application. However, desktop sharing lets you show any part of your
desktop to attendees and quickly share additional applications.

on a “Web tour.” Attendees can view each Web page that you access, either
on the Internet or on your organization’s private intranet. You can
optionally allow attendees to control your Web browser. This option uses
more bandwidth than the following two options.
■ Web content sharing: To share a Web page on the Internet that includes

multimedia effects, such as sound and animation, you can use Web
content sharing. This option lets you specify a URL for a Web page, video,
audio file, flash file, or WebEx Recording, and display the content in the
content viewer on each attendee’s screen. Attendees can hear sounds and
interact with other multimedia effects independently in their content
viewers. This option also lets you share a single Web page more quickly
than you can using the Web browser sharing option; however, it does not
allow you to guide attendees to other Web pages.
■ Presentation sharing: Using the WebEx Universal Communications

Toolkit, you can insert a link to a Web page directly in a Microsoft
PowerPoint presentation. When you share the presentation in the content
viewer during a meeting, using the Presentation or Document command
on the Share menu, the Web page automatically appears on the slide on
which you inserted its link. This option is useful if you want to include a
Web page in your presentation but do not want to stop your presentation
to use either Web browser sharing or Web content sharing. For more
information about creating and sharing presentations in which you insert
media objects, see Using UCF multimedia to enhance your presentation on
page 10.
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Providing handouts to attendees
You can let attendees print handouts at any time during a meeting, as
follows:
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■ Not including more than 20 to 30 slides in one presentation file. If you

want to share more slides, create a separate presentation file for each set of
20 to 30 slides.
■ Keep the size of the presentation file to a maximum of 5 MB.

1 Share the handout by choosing Presentation or Document on the Share

menu, and then selecting the handout document.The handout appears in
the content viewer.
2 On the Participant menu, choose Privileges.
3 In the Attendee Privileges dialog box, select the Print check box, and then

click Assign.
Attendees can now print the shared handout by pointing to Print on
the File menu, and then choosing Document.

Displaying Slide Animations and Transitions
When sharing a Microsoft PowerPoint slide presentation in the
content viewer, you can display animations on the slides and slide
transitions.
After you begin sharing a presentation, you can perform slide
transitions or animations:
1 Click anywhere in the content viewer to set the input focus. A blue border

around the shared slide indicates that the viewer has input focus.

Synchronizing displays
When you share a document or presentation in the content viewer,
some attendees may not be able to view the entire page or slide that you
are sharing, because their viewers are set to different magnifications. To
resolve this problem, simply click the Sync Displays for All button on
the toolbar at the bottom left corner of the Meeting window.

2 Do either of the following:
■ To perform the next slide transition or animation, click the Next Page

button on the toolbar

Next Page button
■ To perform the previous slide transition or animation, click the

All attendees’ content viewers then display the page or slide at the same
magnification that you set in your viewer.

Improving the performance of document or
presentation sharing
You can improve the speed at which shared pages or slides appear to
attendees using these techniques:
■ Limiting the number of animations and slide transitions that you add to

Microsoft PowerPoint slides.
■ Minimizing the number of screen captures that you add to slides,

especially if they are bitmap graphics. Such graphics do not compress well.

Previous Page button on the toolbar.

Previous Page button

Note

If you are unable to display animations or slide transitions,
ensure that you import the presentation using the Universal
Communications Format (UCF) import mode: On the Meeting
menu, choose Options, and then click the Import Mode tab.
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Using UCF multimedia to enhance your presentation

Sharing graphics quickly

You can make an online meeting more engaging by sharing these types
of media files in the content viewer:

You can quickly share a graphics file with attendees by copying it to
your computer's clipboard, and then pasting it in the content viewer.
To copy an image, do one of the following:

■ WebEx Recording Format (WRF) files
■ Video files
■ Audio files
■ Flash movie and interactive Flash files
■ Web pages

To share a media file, you must use a Universal Communications
Format (UCF) media object. A media object links to the media file and
provides a window in which the file appears. An object also contains
options and controls for displaying or manipulating the file.
You can share media files in either of two ways:
■ In a Microsoft PowerPoint presentation: Using the WebEx Universal

Communications Toolkit, a plug-in for Microsoft PowerPoint, you can
insert UCF objects into your slides. You can then share the presentation
during a meeting.You can download the Universal Communications
Toolkit from the Support page on your Meeting Center Web site.
■ As a standalone file: You can share a media file directly in the content

viewer. Meeting Manager creates a UCF object for the file automatically,
which appears in the content viewer.
Note

For more information about creating UCF multimedia
presentations, refer to the guide Getting Started with WebEx Universal
Communications Toolkit. For more information about sharing either
a UCF multimedia presentation or a standalone media file, refer to the online
Help on your Meeting Center Web site.

■ Right-click an image on a Web page or in a document, and then choose

Copy.
■ Capture the active window on your desktop to an image by pressing the

PrtScn (Print Screen) key.
■ Capture your entire desktop to an image by pressing the PrtScn (Print

Screen) key.
After you copy an image to your computer's clipboard, on the Edit
menu in the Meeting window, choose Paste as New Page.
You can paste any bitmap image in the content viewer, such as a GIF,
JPEG, BMP, or TIF image. However, you cannot paste other types of
images—such as EPS or Adobe Photoshop (PSD) images—in the
content viewer.

Optimizing attendees' shared views
These tips can help you to avoid common problems with application,
desktop, or Web browser sharing:
■ Differences in screen resolution settings between your computer and an

attendee's computer may prevent that attendee from viewing the entire
application, desktop, or Web browser that you are sharing. To help avoid
this problem, you can do any of the following:


Ask attendees to reduce the image of the shared software, by clicking
the Sharing button in the upper-right corner of the sharing window,
pointing to View, and then selecting an option.



Ask all attendees to set their monitors to the same screen resolution as
your screen.



Set your monitor to a lower screen resolution, such as 800 by 600
pixels.

Successful Web Meetings
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■ Ensure that the Meeting Manager display mode is set optimally for the
Note

For instructions on setting screen resolution, refer to
Windows online help.

■ You can also resolve some problems with screen resolution by choosing

the View > Show Full-Screen View for Attendees command on the Sharing
menu, which appears in the title bar of the application or Web browser
that you are sharing.
■ To improve the quality of attendees' views of a shared application, ensure

that your screen display and attendees' screen displays are set to the same
color depth—for example, 16-bit color.
Note

For instructions on setting screen color depth, refer to
Windows online Help.

Running applications before a meeting starts
To save time during a meeting, begin run any applications that you
intend to share before the meeting's starting time, and then minimize
their windows. At the appropriate time during the meeting, you can
quickly begin sharing an application, without waiting for the
application to start.

application that you are sharing. You can choose one of two display
modes: one for normal applications and another for graphics-intensive
applications. To set the display mode, on the Meeting menu, choose
Options.

Avoiding blocked views
If you cover a shared application or Web browser with another window
on your computer's desktop, attendees cannot view the area of the
application or browser that the other window covers. Instead, a
crosshatched pattern appears in the covered area on attendees' screens.
To help avoid this problem, ensure that you minimize all applications
that are running on your computer, and then restore the window for
only the application or browser that you want to share.
To ensure that you do not block a shared view and create the
crosshatched pattern, use a second computer to join the meeting as an
attendee and monitor the attendees' view of your presentation.

Transferring files to attendees
During a meeting, you can transfer any types of files to attendees, by
choosing Transfer on the File menu. The following are some examples
for using this option:
■ Provide attendees with a copy of your presentation or any other

documents that you share during the meeting.

Improving the performance of software sharing
To improve the performance of software sharing, do the following:
■ Close all applications that you do not need to use or share on your

computer. Closing applications conserves processor usage and memory on
your computer, thus helping to ensure that Meeting Manager can send
images of shared software quickly during a meeting.
■ To ensure that the maximum amount of bandwidth is available for

software sharing, close any applications on your computer that use
bandwidth, such as instant messaging or chat programs, and programs
that receive streaming audio or video from the Web.

■ If you are training attendees on how to install and use an application,

provide attendees with the application's installation program. Then, use
desktop sharing to show attendees how to install the software.
■ If you take a poll during a meeting, provide attendees with a copy of the

poll results file that you saved. Attendees can open a poll results file using
any text editor.

12 of 15

Successful Web Meetings

Recording, playing, and editing meetings
This section describes the various options for using WebEx recording to create
a video recording of all screen activity on your computer, including all
interactions, sharing, and audio. In addition, it provides information on
editing and streaming your recordings.

Recording meetings
If you want to record a meeting—for example, for a remote team in
another time zone—you can record the meeting using WebEx
Recorder. You can then publish the recording on your organization’s
Web site or intranet. Members of the remote team can use WebEx
Player to replay the meeting at any time.
WebEx Recorder is available in these versions:
■ Network-based meeting recorder

The network-based meeting recorder is available during an online
meeting. This recorder captures screen activity and audio on a WebEx
recording server, thereby saving processor resources and hard disk space on
your computer. The server automatically processes your recorded data,
and then sends the recording file to your personal folder on your Meeting
Center Web site.
Use the network-based recorder to easily capture all audio in your
meeting’s teleconference, without having to use a phone recording adapter
(a device that connects your phone to your computer’s sound card).
However, if you want to capture audio in an Integrated VoIP conference,
use the integrated meeting recorder instead.
■ Integrated meeting recorder

The integrated meeting recorder is available during an online meeting.
This recorder captures screen activity and audio in a meeting, and then
saves the recorded data in a recording file on your computer.

Use the integrated recorder to capture all audio that plays “through” your
computer, such as an Integrated VoIP conference or sound that media files
play. You can also capture audio in a traditional teleconference using a
phone recording adapter, which connects your phone to your computer.
■ Standalone recorder

The standalone recorder is available only offline—that is, outside of an
online meeting. This recorder lets you record all screen activity in any
application on your computer, and then saves it in a recording file on your
computer.
Use the standalone recorder to create software demonstrations, tutorials,
sales presentations, and so on. To capture audio in an application
recording, simply connect a microphone to your computer.
You can download the standalone recorder from your Meeting Center
Web site.
For detailed instructions on using WebEx Recorder and Player, refer to
the WebEx Recorder and Player User’s Guide.

Editing your recordings
Before you distribute or publish a recording that you made using
WebEx Recorder, you can edit it to remove mistakes, long pauses,
unwanted segments, and so on. You can edit any WebEx Recording
Format (.wrf) file that was made using the WebEx Recorder.
To edit a recording, you must use WebEx Recording Editor, which is
available on the Recording and Playback page on your Meeting Center
Web site.

Streaming recordings on your company’s Web site
On your company’s Web site, you can publish recordings that users
have created using WebEx Recorder. Then, anyone who visits your Web
site can play the recordings by streaming them over the Internet.
Streaming allows people to play the recordings without downloading
them to their computers.
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To stream recordings, you can use Create a URL for Recording page on
your Meeting Center Web site. For more information, refer to the
“Recording and Playback FAQ” on your site. This FAQ includes a link
to the guide Streaming Recordings on Your Web Site.
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To set up a dual-mode voice conference, on the Teleconference page in
the Advanced Scheduler or the Change Audio Options page in the
Quick Scheduler, select both a teleconferencing option and Integrated
VoIP.
Note

Hosting a large meeting

For detailed information about setting up a teleconference
and using Integrated VoIP, refer to the online Help on your Meeting
Center Web site.

For meeting hosts
This section provides tips and techniques that can help you to host a
meeting with a large number of participants more effectively.

Providing technical support

Muting audio

Provide attendees with a phone number that they can call to receive
support from your technical support personnel. Having this phone
line available helps to ensure that all attendees can fully participate in
a meeting.

If you are using the integrated WebEx teleconferencing service, you can
prevent distracting noises during a meeting by muting the audio for all
participants in a teleconference. To do so, on the Participant menu in
the Meeting window, choose Mute All.

Using two computers
To ensure that attendees can view shared presentations or applications
properly, you (or the presenter) can monitor their view of the meeting
by using two computers. Use one computer to present information,
and use the other computer to view the meeting as an attendee.

Setting up a dual-mode voice conference
If your meeting requires only one-way audio—that is, a meeting in
which attendees listen to the presenter but do not speak themselves—
you can set up a dual-mode voice conference.
A dual-mode voice conference includes both a teleconference and an
Integrated VoIP conference. Attendees can choose to listen to audio
using either their phones or speakers attached to their computers. For
example, if joining the teleconference would require an attendee to
make a long-distance call, the attendee could use Integrated VoIP
instead.

To avoid having attendees interrupt a meeting when they need help,
provide your support number on the first slide in the content viewer,
in the header of each slide, or in the agenda.

Establishing meeting guidelines
To help keep a large meeting running smoothly, you can provide
attendees with a list of meeting guidelines to follow. For example, you
can specify how and when attendees can ask questions, request
annotation control, request remote control, and so on. To provide your
guidelines to attendees, choose either option:
■ When scheduling a meeting, specify your guidelines in the agenda.
■ Include your guidelines on the first slide in your presentation. Once

attendees join a meeting, they can read the guidelines before the
presentation starts.
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Designating a chat moderator

Testing dial-up and high-speed connections

Chat provides a convenient way for attendees to ask questions during a
large meeting. To ensure that attendees receive timely answers to their
questions, and to avoid interrupting the meeting, you can designate
another attendee as a chat moderator. The moderator can answer
attendees' questions in chat messages. At the beginning of the meeting,
instruct attendees to use chat to ask questions and to direct their
questions to the chat moderator.

If you use a dial-up connection, poor phone lines and equipment in
your area may affect your meeting experience. If you suspect that such
a problem exists in your area, contact your phone service provider.

Handling disruptive attendees
To prevent a disruptive attendee from taking control away from the
presenter, be careful when granting privileges to attendees. If an
attendee continues to disrupt a meeting, you can expel the attendee by
selecting the attendee’s name on the Participants panel, and then
choosing Expel on the Participant menu.
Once you expel an attendee, you can prevent the attendee from
attempting to rejoin the meeting by choosing Restrict Access on the
Meeting menu.

Solving common problems
The following are tips for solving and avoiding some common
problems that you may encounter when using your Meeting Center.

Even if you use a high-speed connection—such as ISDN, DSL, T1, or
T3—you may experience bandwidth limitations or data loss. These
problems may originate with your ISP or a major hosting facility in
your area. For example, some ISPs use proxy servers to handle inbound
and outbound network traffic. These servers can reduce your
connection speed and thus affect the performance of Meeting Center.
To determine the speed of your connection and whether any problems
exist with your connection, you can use traceroute—a utility that
records the route that data traverses on the Internet between your
computer and a specified destination computer.
To use traceroute on a Windows computer to test the connection
between your computer and the computer that hosts your Meeting
Center Web site, follow these steps:
1 On the Start menu, point to Programs, point to Accessories, and then

choose MS-DOS Prompt or Command Prompt, depending on your
computer’s operating system.In the MS-DOS Prompt or Command
Prompt window, type your Meeting Center Web site’s URL, which has the
following format:
tracert <your_organization_name>.webex.com

where <your_organization_name> is the name of your organization.

Using a dial-up connection

2 Press Enter.

Attendees who use dial-up connections to the Internet can avoid
unnecessary delays in screen updates during a meeting by connecting
to their local ISPs, rather than to their corporate servers. Connecting to
a corporate server can cause delays in receiving meeting data because
the data must traverse a longer path, and thus is more likely to traverse
congested lines.

The traceroute results indicate how many hops—or routers—that data
must traverse to reach your Meeting Center Web site, and the time it
takes for data to reach your site, in milliseconds (ms). On a good
connection, data takes between 15 to 100 ms to reach its destination. If
the data's travel time is longer than 100 ms, your connection is slow. In
this case, examine the results to determine where the data's path
became slow. You can help to isolate a problem by tracing the route to
a well-known Web site, such as www.yahoo.com, and comparing the
results to those for the route to your Meeting Center site.
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Clearing your Web browser's cache

Providing feedback about this guide

Clearing your Web browser's cache can improve your browser’s
performance, and thereby your meeting experience. To clear you
browser's cache, follow the instructions provided in your browser’s
online Help.

If you have comments about this guide or other WebEx
documentation, please send an email message to docs@webex.com. In
your email message, please specify the section to which your comment
applies. If you would like to receive a response to your comments,
please include your name and contact information in your message.

Handling firewall problems
Your Meeting Center Web site sends and receives all meeting data
through port 80—your firewall's standard HTTP port. You need not
open any other ports on your firewall. If port 80 is open on your
firewall but you still cannot use your Meeting Center Web site, please
contact technical support.

Contacting WebEx
Obtaining assistance
To receive technical support for Meeting Center, go to the Support page
on your Meeting Center Web site, as follows:
1 On the navigation bar, expand Assistance.
2 Click Support.

Support contact information appears on this page.

Providing feedback to WebEx
At WebEx, we value your comments about our software products and
documentation.

Providing feedback about Meeting Center
To provide feedback about Meeting Center you can send an email
message to feedback@webex.com.
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